
GENERAL CLUB MEETING   
7:00 P.M. 

4th Wednesday of the month at the  
Midland Community Center 

2001 George St., Midland,  MI 
 
This month’s date:   
February 27, 2013 
 
 
This month’s topic: eBooks and the 
Library presented by Ann Jarvis 
from Grace A. Dow Memorial 
Library  
 
 
What you missed!  Windows 8 - The Basics - 
presented by Howard Lewis 
 
 
Program Coordinators 
Howard Lewis  lewis3ha@chartermi.net  
Bill Tower tower.w@gmail.com 
 
Please let Howard or Bill know of topics you 
would like covered at future meetings.  
 

President Piper’s Ponderings 
Gibbs on NCIS is known to have 50 
Rules which governs his job and his 
life. 
 

This led me to develop my own 50 
Life Rules. I have extracted ten of 
those which I felt were relevant to 
dealing with computers, hence 10 
Computer  Rules . Their sequence represents only 
the order in which I originally thought of them. 
 

#2-What knows he of England, who only England 
knows? Kipling (Sales people should know not only 
their only product, but their competition’s products.) 
#3-Don’t believe what you are told; always double-
check your facts. (Applies to everything you hear.) 
#12-Reach your own balance between dealing with 
facts and dealing with people. (Both are necessary 
to get anything done.) 
#26-When you raid the cat house, you take the 
piano player too. (Buying a Mac means buying into 
the entire Apple ecosystem.) 
#36-Perception is reality. (Judge people by their 
actions and the friends they keep.) 
#38-When the student is ready, the teacher will 
appear. (This helps when you want to learn 
something new?) 
#41-Don’t ask your barber if you need a haircut. (Be 
careful who you seek advice from.) 
#45-If you can’t be right, be wrong at the top of your 
voice. Lucy (Beware of these people.) 
#49-Know when to ask for help; not too fast and 
definitely don’t wait too long. (This applies to 
everyone from peons to Presidents.) 
#51-Sometimes you’re wrong. (Again, this applies to 
all of us.) 
 

Maybe we can exchange each other’s Life Rules at 
the next General Meeting. 
 

(The above comments are the opinion of the author and 
do not necessarily reflect the views of the Midland 
Computer Club.) 
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2013 MCC  OFFICERS 
President      Larry Piper  larryp56@chartermi.net 
Vice Pres.    Joe Lykowski joseph@lykowski.com 
Treasurer     Laura Hammel Lhammel@gmail.com 
Membership  Gary Ensing btiger6@gmail.com 
Editor 
Webmaster  
 
            Special Interest Groups: 
 
PROGRAM COORDINATORS 
Howard Lewis lewis3ha@chartermi.net  
Bill Tower tower.w@gmail.com 
 
PUBLICITY 
Al Adams aladams12@yahoo.com  
 

 

    Membership  Enrollment  Form        
 
       NAME  _______________________________________           PHONE  __________________ 
 
       ADDRESS  ___________________________________________________   
 
       CITY    __________________              ZIP  _______________       
 
        EMAIL ADDRESS     ___________________________________________ 
 
       Membership dues   FAMILY ($20)      STUDENT ($15)     New Member ____    Renewal   ____ 
 
                     Please fill out the above form and mail it along with payment of check or money order to : 
 
           MIDLAND COMPUTER CLUB         Attn: Memb ership Chairman 
              1816 Bauss Ct 
             Midland, MI  48642-4023   
                                                                      You may also pay for membership at a regular club meeting 

Board Meeting 
First Thursday of the month 

7:00 PM 
Chapel Lane Presbyterian Church,  
5501 Jefferson Ave., Midland MI 

 

Useful, useless and strange (in no 
particular order) Web Sites: 
 
http://tinyurl.com/bjokbl9 
If you have upgraded to Windows 8, or are thinking 
about upgrading to Windows 8, this video might be 
a big help. This video is by Scott Hanselman, a five 
year Microsoft employee, who felt that there was 
inadequate learning information about Windows 8. 
So on his own, he generated this 25 minute video 
he has entitled “The Missing Windows 8 
Instructional Video.” 
 
http://www.howcast.com/ 
This site hosts quite a number of “how-to” videos, all 
the way from technical to family. 
 
http://www.madeinusa.org 
You can either use their catalog or search for 
products which are made in the U.S.A. 
 
http://meetingboy.com/ 
For a good laugh, read some of the comments 
made by various people regarding their jobs. 
 
http://tinyurl.com/chbcfqu 
Here is a great video on a Canadian reporter who 
goes out into a northern Ontario park to help in the 
annual census of black bears. You will get a chuckle 
or two out of some of his comments. 
 

Carol Picard   webbyte@yahoo.com 
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Tips, Tricks & Techniques 
 
Rearranging Tiles On the Windows 8 Start Screen  
 
When you first start up Windows 8, you find 20 tiles staring at you from the Start screen. The Start screen 
has replaced the Start menu that has been found in previous versions of Windows ever since Windows 
95. There are a several things that can be done with these tiles to make the Start screen more personal 
and easier for you to use.  
 
 
Figure 1  shows the Start screen which 
normally appears when starting Windows 8 up 
for the first time. For most of us “old-time” 
Windows users, the most frequently used tile is 
the one in the lower left corner of the screen, 
which allows you to switch over to the 
“desktop” screen, with which we are usually 
familiar.  But, this figure also shows that tiles 
can be larger (the Mail tile) or smaller (the 
Maps tile) and dynamic (the Weather tile) or 
static (the Messaging tile). All of these 
properties can be changed.  
 
 
 
 
 
 
For example, any of these tiles can be made smaller by simply right-clicking on the tile (Figure 2 ) and 
selecting Smaller on the bar which is displayed at the bottom of the screen.  
 

 
 

Figure 1 

Figure 2 
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Figure 3  shows the results of making the 
Calendar tile smaller. By making the tiles smaller 
you can now fit more tiles on the first page of the 
Start screen, but you lose some functionality in 
the “dynamic” tiles (to be discussed at another 
time).  
 
 
 
 
 
 
 

 
 
 
Another useful way to arrange tiles is to move those that are the most frequently used to the beginning of 
the list so that they are available on the first page of the Start screen. To accomplish this, simply click on 
the tile and move it to wherever you want it to be positioned.  
 
 
 
 
 
Figure 4  shows that the Camera tile has been 
repositioned in the space vacated by the Calendar 
tile when it was reduced in size. With these two 
procedures, you can make the Start screen much 
more useful for your particular needs. 
 
 
 
 
 
 
 
 
 
 
 
Another thing that can be done is to group tiles into logical groups. If you notice, in the preceding 
examples, there are two groups on the Start screen. This is indicated by the larger space between the 
groups (for example, between the Photos tile and the Games tile). You can create additional groups as 
necessary to collect like apps together to easily find the item you want.  

Figure 3 

Figure 4 
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Figure 5  shows that when dragging the Video tile into the space between the groups, a light bar appears. 
By dropping the Video tile on this light bar, a new group is formed.  
 

 
 
 
 
Figure 6  then shows the result of collecting all of the tiles associated with photos and movies together in 
one group.  
 

 
 

Figure 5 

Figure 6 
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Document Your Life with Photo-Graphic Memory - Page 6 
 By Phil Sorrentino, Member, Sarasota PCUG, Florida 
Get creative with Text Boxes - Page 8 
 Nancy DeMarte, Regular Columnist (Office Talk), Sarasota PCUG, Florida 
How to Override Acrobat’s Security Block - Page 9 
 Linda Gonse, Editor/Webmaster, Orange County PC Users’ Group, CA  
Have Fun and Learn with PAINT - Page 12 
 Jim Cerny, Director, Sarasota PCUG, Florida, November 2012 issue, Sarasota PC Monitor 
Back To Basics - Using Menus - Page 13 
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Articles in this Newsletter have been obtained from APCUG with the authors’ permission for publication 
by APCUG member groups. The Midland Computer Club has not verified the information contained in 
the articles nor tested procedures or hardware/software. Articles do not necessarily reflect the views of 
the Midland Computer Club. 
 

 
 
Document Your Life with Photo-Graphic Memory 
By Phil Sorrentino, Member, Sarasota PCUG, Florida 
September 2012 issue, PC Monitor, www.spcug.org, pcugedit (at) verizon.net 
 
A photographic memory is probably something we all would like. And, just think, you can have at least the 
effect of a photographic memory just by using your camera and your computer to document your 
activities… your life. 
 
It is amazing how much paper we collect along the way. Most of it goes neatly into file folders and then 
those folders go neatly into multi-draw filing cases or boxes. Before you know it you have multiple multi-
draw filing cases in the den, the home office and/or the bedroom closet. Have you ever looked at the pile 
of paper you have collected over these many years?  It’s not a pretty picture. Now there are some things 
that we just have to hang on to, like licenses, automobile registrations, titles of any sort, and certain 
special papers that might have an emotional or historical attachment. But the rest of the pile might be 
eliminated or at least pared down. (And how about old tax forms?  How many years do you have to keep 
the paper?  Or is an electronic copy good enough for taxes paid 10 years ago?)  
  
What I’m suggesting is that with your computer, and a scanner and a camera, you can probably cut the 
paper you need to save down to a very manageable size, and even eliminate some of those storage 
cases. The scanner is really the key here. The camera is for unusually large items, or those things that 
just can’t be copied on a flat-bed scanner. Consider this, review the contents of some of those folders and 
if you need to know that something occurred, and is relevant, like an award you were given from your last 
employment. If you have not looked at it since you received it, then you can probably scan it in and throw 
away the original. I know how difficult this will be for some people, but after a little practice it will get a lot 
easier. (A very important thing here is that you have adequate “backup” to guarantee that you will never 
lose the scanned in files. If you don’t have adequate backup, which means multiple copies of the data files 
of the scanned objects, then this is not going to be a good idea. So before you commit to this, make sure 
you have a good backup plan in place. Make sure that you can guarantee at least two if not three copies 
of the scanned in files. The first two copies could be two external or portable disk drives and the third 
might be on DVD or a flash memory device.)  Once the backup plan is in place and you are really using it, 
the fun begins. Gather your papers, separate the ones that you have to keep and make a pile of those 
that can be shredded after they are scanned. Do you really need those greeting cards you received 15 
years ago? 
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In order to make sure that you can retrieve any of these “documents”, it is good to establish a naming 
convention before you start to scan the paper documents; after all, it is no use to have all the data if you 
can’t access it quickly. As you collect your scanned documents, you will be creating a database. Two 
popular ways of organizing your database are 1- by date, and 2- by event. If every file that you want to 
keep has a name starting with “yyyy-mm-dd” and is followed by a descriptive name, then when the digital 
files are put in a digital folder, they will organize in a chronological fashion. yyyy represents the year, like 
2011, mm represents the numerical value of the month like 04 for April, and dd represents the day of the 
month like 01 for April 1. (For some databases only the year and month may be adequate.)  Now, when 
you go looking for a document, all you have to know is the date associated with the item, and you can just 
look in the chronological order to find it. 
Let’s say that if you scanned in an 
award that you received in June 1976, 
then you would look in the area of 1976-
06, to find that document. Windows 
Explorer makes it easy to find scanned 
documents because it shows a 
thumbnail photo of the file, while you 
are searching for the file. This is 
especially helpful because a scanned 
file is usually saved as a .jpg file, a 
picture file. 
 
If you do use this naming convention, 
then you can organize your folders to 
represent either years (or groups of 
years), or events. If you choose to be 
completely chronological, then the 
folders will be named 1970, 1971, 1972,
… you get the idea. Then you could put 
the 1970s folders into a folder named 1970s, and you 
could do the same with all other decades. If you choose 
to organize around events, then the folders might have 
names like “awards”, “house info”, “car info”, “career”,.. – 
really, any collection of events or things that makes 
sense to you and any others who will use the database. 
 
Besides your scanned in documents, you can include 
photos from your digital camera. If you use the same 
naming convention with your photos, then you can mix 
them in with the documents and they all will organize in 
chronological order. Sometimes that makes a lot of 
sense when you have both pictures and documents that 
are part of the same event. This combination sometimes 
helps tell the complete story of the activities of the 
specific event. 
 
Another way to organize your database is to organize 
your folders around event; then you might name your 
folders “birthdays”, “anniversaries”, “parties”, 
“weddings”,… you get this idea too. So these would 
represent those types of events throughout the years. 
The fact that the files are chronologically named means 
they would organize chronologically inside the folders, 
making it easy to find a specific event within an event 
folder. And you can mix the two types of database folders. You could have your basic folders 
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chronologically named, but inside a year you might have a series of events like “a vacation trip to the 
Grand Canyon” where the pictures from the trip would show what you saw and the documents you 
collected like maps and brochures from the particular destinations. As long as each file is chronologically 
named, the files will organize in a way that will make it easy for you to find a specific document, or group 
of pictures. 
 
Not only do you save storage space, but once your pictures and documents are in your database, they 
are immediately available because they are literally at your finger tips (if your fingers are on the 
keyboard). I bet you’ll be able to impress your friends how fast you can find those awards you received 
from your first employer. Of course there are always a few items that just can’t be committed to electronic 
files and there are always a few pictures of the grandchildren that just must be made into an 8 by 10 for 
the wall. But, just think, with a lot of those paper documents shredded, and all of your photos committed to 
digital files, you won’t need all of that paper and picture storage. It will probably free up some valuable 
storage space and maybe you can even make a few bucks by selling those filing cabinets.  

 
 

 
Get creative with Text Boxes 
Nancy DeMarte, Regular Columnist (Office Talk), Sarasota PCUG, Florida 
September 2012 issue, Sarasota PC Monitor, www.spcug.org, ndemarte (at) Verizon.net 
 
When you use Microsoft Office, you create and edit text all the time. Word, of course, is dominated by 
text; Excel and PowerPoint both use text in many of their functions. All recent versions of Office also 
include a tool called a “text box” for special uses of text. Let’s find out what it is and how to use it. 
 
A text box is a specialized shape in which you can enter text. It functions outside the regular margin 
constraints of a document and can be moved or resized as needed. A text box is useful for adding a 
caption to a photo or annotating a diagram or chart. If you want to emphasize an important statement in a 
document, you can use a text box to repeat the statement in a “pull quote” and locate it in an unexpected 
spot, such as along a margin (known as a Sidebar) or across columns in the document. Its flexibility 
makes a text box useful in many situations. 
 
Text boxes have most of the same properties as shapes. In Word 2007 and 2010, when you click the 
Insert tab, then Text Box, you open the Text Box gallery of 36 preformatted text boxes, as well as the 
“Draw text box” option. If one of the preset boxes meets your needs, click to insert it into the document. 
Older versions of Word lack this gallery, but you can still draw a text box, which is most often my choice. 
Click “Draw text box” at the bottom of the gallery. Then click anywhere in your document where you want 
the text box to appear and drag diagonally down the page to the right to create the text box. At first the 
box covers a portion of the normal text. This is because the default text wrapping setting is “in front of 
text.” If you don’t want the text box to hide the document text, select the text box so “handles” appear 
around the box. At this point, the Text Box Tools Format tab appears on the ribbon. Click Format, and 
then Text Wrapping in the Arrange group. Change the setting to Tight, which will position the text box 
within the existing text and also allow you to move the text box. Do this by clicking an edge so a crossed 
arrows icon appears and dragging it to a new location. You can also resize the box by dragging an edge 
or corner. To enter text in the box, replace the informational text with your own.  
 
Once a text box is created and located in the document, it can be formatted in many ways. To format the 
text, select it, and a small version of the Font group on the Home tab will appear. Use these tools to 
change the font style, size, color, and other attributes. (You can also click the Home tab and use the full 
set of options in the Font group.) To format the text box itself, select it and use the tools on the Text Box 
Tools Format tab. For example, you can fill the box with a color, remove or change the border styles, 
make the text read vertically, or add special 3-D effects.  
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In Office 2007 and 2010, text boxes are not limited to a rectangular shape. You can add text to any of the 
items in the shapes gallery. Click Insert – Shapes and click a shape. Click in your document and draw the 
shape in the same way you drew the text box. Change the text wrapping to Tight as you did above, then 
right click inside the shape and choose “Add Text.” The large number of shape choices gives you many 
options for text boxes. Another approach is to begin with a classic text box, even after it is filled with text. 
Select it, which opens the Text Box Tools Format tab. Click Format and select “Change shape,” which 
opens the shapes gallery. Click a new shape, and the text box transforms into that shape with all its 
contents intact. Another interesting possibility is inserting a photo or piece of clip art into a text box. With 
the text box or shape selected, click the Insert tab – Picture. Click the photo you want, then Insert. The 
photo appears in the text box, resized to fit. The same steps work to insert clip art, charts or tables within 
text boxes. 
 
Text boxes can be rotated for a dramatic effect. In Office 2010, select the text box, and click and drag the 
little green rotator circle above the box to rotate it left or right. In Word 2007, for an unknown reason, 
classic text boxes cannot be rotated, even though shapes can. One way to work around this problem is to 
create a text box, cut it using the Cut command on the Home tab, and then paste it as a “Picture 
(Windows Metafile)” using the Paste Special command option under the Paste icon.  
 
Occasionally, you might create a text box in Word that you’d like to reuse at a later time. You can save it 
by selecting the text inside the box and then clicking Insert and the arrow under the Text Box icon. 
Choose “Save Selection to Text Box Gallery.”  
 
Besides Word, text boxes appear in Excel and PowerPoint 2007/10. Neither program contains a text box 
gallery, but each has the “Draw a Text Box” tool, which gives you all the functions that Word does, 
including rotation. You can also start with a shape and include text by right clicking and using the “Edit 
Text” command. 
 
Have a little fun. Create a few text boxes in your next document, spreadsheet or presentation. 
 

  
 
How to Override Acrobat’s Security Block 
Linda Gonse, Editor/Webmaster, Orange County PC Users’ Group, CA  
August 2012 issue, nibbles & bits, www.orcopug.org, editor (at) orcopug.org 
 
It came as a surprise to me that the link I was clicking on in the newsletter’s pdf did not open. Nearly all of 
the newsletter’s web addresses have been shortened to make it easier for readers that prefer to type 
them into a browser. 
 
My next surprise came from the error message (image below) that popped up.

 
 
Acrobat will prevent you from opening links to doma ins that have been blocked. 
First, I checked my version of Acrobat Pro. It is 10.1.3. I had recently upgraded and prior to the upgrade 
was able to click on the bit.ly links with no problem. 
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Then, I went online to check what other people were saying and doing about this security block.  
http://adobe.ly/OVYSbA 
 
I discovered that they were not all happy with it, but there is a way to make the links work that are from 
domains that you know and plan to visit.  
 
You will need to open Acrobat and go to Edit and to Preferences. In the Preferences dialog box, select 
Trust Manager in the list on the left side.  
 
 
The dialog box automatically changes to show you the options available. Click on the button to Change 
Settings. 

 
 
 
You can tell Acrobat what sites you want to open fr om a link in a PDF. 
 
Find the URL that you want to open from a link. In my case, it was bit.ly. To the right of it were the words 
Always Block. Click on the domain name and click the Delete button. Then, click OK, and close the 
program.  
 
In this box, you could also type in the URL you want to change instead of clicking on a link. I found it 
easier to have the program add the domain name for me and it was less hassle in the event that I 
misspelled it. 
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Check that the words to the right of the domain now  say Always Allow. 
 
I reopened Acrobat and the newsletter. Then, I found a bit.ly link in it and clicked on the link. A message 
came up telling me that the document was trying to connect to bit.ly and asked if I would allow it. Before I 
clicked on Allow, I checked the box to “Remember this action for this site for all PDF documents.” Then, I 
clicked Allow. 

 
 
 
 
 
 
 
 
 

Check “remember this action” and press Allow. 
 
To see the change you made by  this action, retrace your steps to the Trust Manager and Change 
Settings. Look for the URL you wanted to change and you will note that the words to the right of it now say 
Always Allow. 
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Have Fun and Learn with PAINT 
Jim Cerny, Director, Sarasota PCUG, Florida, November 2012 issue, Sarasota PC Monitor 
www.spcug.org, jimcerny123 (at) gmail.com 
 
Feed your creative side!  Learn a little about computer graphics.  
 
I’ve always liked the Paint program -- it comes free with Windows. Sure, there are other drawing and 
graphic programs you can use, many of them free on the internet, but since everyone who has Windows 
has the Paint program, you might want to know a little about it. To open Paint on your computer click on 
the “Start” button in the lower left of your screen, then move your mouse to “All Programs” and a list of 
your computer programs will be displayed. Scroll down to the “Accessories” folder and click on it. In the 
list of programs in the Accessories folder find “Paint” – click on it once and it will open. You can play with 
Paint and make your own drawings and you can open a photo in Paint and then draw or put text right on 
the photo. But before we do that, let me tell you why I like the Paint program and why I think it is worth 
your time to learn about it. 
 
Paint is an excellent program for new computer users because it can teach you some basic computer 
commands for doing graphics. You can draw and work with shapes, colors, lines, pictures, and more. But 
the important thing is that what you learn in Paint will come in handy in many other graphic programs. 
Paint is also an easy program to learn on your own by using its own “help” option. When you open Paint 
(in Windows 7), click on the little blue circle with the tiny white question mark in the upper right corner of 
the window (or just hit the “F1” key on your keyboard). Then click on the article title you want to learn 
about. I suggest starting at the top and read all the sections if you have not used Paint before. Don’t 
worry, the entire help article is not long and you can read it all in less than a half hour. But you really need 
to actually do what the instructions tell you so that you will build up your computer skills. The program is 
simple enough to learn easily and it will introduce you to some great computer graphics. But, on the other 
hand, Paint is limited in what it can do. For example, it is not intended to be a complete photo editing 
program by any means. 
 
Play with Paint for a while and learn how to draw and change shapes. Select different colors and draw 
some lines, circles and squares (to draw perfect circles and squares, hold down the “shift” key while you 
drag your mouse to create the shape). Try selecting different brush types – you can select oil or water 
color, for example, or crayon or marker. Notice how you can see “through” some colors to the others 
underneath (Paint prior to Windows 7 does not have this feature). Now draw a text box by clicking on the 
text tool which is a capital letter “A”. In the box will be the insertion point ready for you to type your text. 
You can make the box “transparent” or “opaque” and move it wherever you want. Make a mistake? – just 
click on the “undo” arrow, the small blue arrow curving to the left at the very top-left of the Paint window. 
 
One thing Paint can do is allow you to put text right in your photo. If you click on “help” you will see the 
“Adding text” title – click on it to learn how. But let me step you through this, one step at a time (in 
Windows 7), to introduce you to this: 
 
1. Open the Paint program (see instructions above). 
2. Click on the dark blue rectangle in the upper left of the window. This used to be the old “file” menu but 

in Windows 7 the word “file” is gone. (No, I don’t know why they removed the word “file”!). 
3. Click on “Open” which will display a window in which you can find the photo you want to work with in 

Paint. Click on the photo and click on “Open” at the bottom right of the window. The photo will now be 
in the Paint program window – but wow -- look how big it is! 

4. Why so big?  Well, I guess the Paint program is used to dealing with images with fewer pixels, but it’s 
no big deal – let’s zoom out to see the whole image at once. Click on the “View” tab and then click on 
the “Zoom out” tool until you see the whole image in the window. Now we can work with it much more 
easily. 



Bits and Bytes February 2013 Page 13 

 

5. Click on the “Home” tab and then click on the “Text” tool – this is the large capital letter “A” in the 
“tools” section of the Home tab ribbon. You are now ready to draw a rectangle in which you will type 
your text. 

6. On the photo, drag your mouse (hold down the left mouse button) to draw a rectangle. If you draw it 
in the wrong place, just move it to where you want by dragging it with your mouse. You can also 
change the size of the rectangle by dragging the little white “handles” at the corners or sides. Try it! 

7. When you draw this rectangle, the “Text” or “Text tools” tab is opened for you. This is where all the 
text editing tools are, and there are not that many. 

8. The “insertion point” is already in the rectangle ready for you to type your text – but wait a second, 
where is that insertion point again?  It is in the upper left of the rectangle you drew, but it may be 
VERY tiny!  Can you even see it?  The Paint program had no idea how large your photo was going to 
be so the larger (i.e. more pixels) your photo is, the smaller the font will appear. Remember, we 
zoomed out to see the whole photo. So, get the font larger by clicking on the little black arrowhead 
next to the number in the “Font” tool area and pick a big number, say “72” and see how big that is. 
You can enter numbers larger than 72 if you want by using the keyboard. 

9. Select a color for your text. Pick a color from the color pallet that will stand out on the photo, such as 
yellow. Just click on the color you want and that color should then appear in the “Color 1” box. This 
will be your text color. 

10. You can select other text options if you wish, such as bold, italic, or a different font. Also, select if you 
want your text box to be transparent (my choice) or if you want it to be “opaque” (that is, to have a 
background color). The background color will be the color in the “Color 2” box which you can change 
if you want by clicking on that box. If your text color and the background color are the same, you will 
see no text! 

11. After you type your text you can still move the box to where you want by dragging it. Once you click 
outside the box, that’s it, your text is now part of the photo and the box is gone. If you make a 
mistake, just click the “undo” blue arrow at the top left of the window and you can try again. 

12. Save your photo with a NEW NAME. Click on the blue rectangle again (the old “file” menu), move 
your mouse to “Save as…” and then click on your file type (probably “.jpg”). In the window that opens, 
pick the folder into which you want to save your photo and enter a good name in the name box. Click 
“Save”. If you do not give it a new name it will replace your old photo which will be lost. 

 
I think you will enjoy using the Paint program, let it bring out the artist in you. While you are drawing your 
masterpiece, you will be learning some very helpful computer skills. Computer graphics can really do 
some amazing things and there are several programs free on the internet if you want to do more. So 
have fun and get colorful! 
 

 
 
Back To Basics - Using Menus 
Jim Cerny, Director, Sarasota PCUG, Florida 
August 2012 issue, Sarasota PC Monitor, www.spcug.org, jimcerny123 (at) gmail.com 
 
You walk into McDonald’s or Burger King and up there on their nice flat-panel displays are their menus. 
Their choices are limited so their menus are short. But if you go to the Ritz and ask for the wine list – 
wow, what a list of choices!  And their choices are grouped into categories too. Each restaurant has its 
own menu of choices. So do computer programs. 
 
Menus, toolbars, and ribbons are the tools we use to do what we want in a program. They provide us with 
specific commands (or actions) or options we can change. Whether you are playing a game, creating a 
document, are on the internet, or doing email, every program has options (or commands) and these 
options can be changed by you. Toolbars and ribbons have symbols (icons) which are intended to give 
you a visual clue as to what that tool or option does. If you don’t want to guess, just “hover” your mouse 
(that is, move your mouse so the arrow is pointing to a tool symbol) and a small box will appear with the 
name of that tool. This is a good way to learn the tools or icons you want to use. 
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Menus, however, use words to tell us what the option or command is. Clicking on (use the left mouse 
button please) the word of a menu, such as “File”, or “Edit”, or “Help” will open a menu of options for you. 
(Ribbons are another form of a tool bar of options). Sometimes you will not see the full and complete 
menu right away, just wait or click on the arrow at the bottom of that short list to get the complete menu. 
(The shorter list that first appears shows menu commands that you have recently used.)  Menus have no 
“X” in the upper right corner to close the menu unless the menu opens in a window. Sometimes a menu 
will appear because your fingers hit some wrong keys. So how do you get rid of a menu without doing 
anything? – Just click OFF of the menu and the menu will go away (and no option is selected). If you do 
want to select one of the menu options, just click on it. What happens next is either the command or 
option will be put into effect, or you may get another menu or window with more options. Microsoft and 
most other software (programs) have generally agreed on some conventions for menus. Although these 
may not always apply, try looking at some menus in the programs you use to see if these work: 
 
• If a menu has a letter underlined try holding down the “Alt” key on your keyboard and then hitting that 

letter. The menu should appear without you using the mouse to click on it. 
• If a menu item has three periods after it “…” it means that selecting that item will open another menu 

or window of options. 
• If a menu item has a keystroke code next to it, such as “Ctrl + P” or “Ctrl + C” it means that this 

command or option can also be made by hitting that key combination on your keyboard without 
having to open the menu at all. To do “Ctrl + C” for example, you hold down the control key on your 
keyboard and then hit the letter “c” key. 

• If a menu item has an arrow next to it pointing to the right, it will show you more options under that 
menu when you pause your mouse there. 

• You can use the arrow keys (up and down) to move to the menu option you want, then hit the “Enter” 
key to do it. If a menu item has a right-arrow, hit the right-arrow key to see that list. 

• If a menu item is in gray (i.e. not black) it means that you can not use that menu option now. For 
example, you cannot use the “copy” menu option until you have first highlighted or selected 
something to copy. So, that command will be gray in the menu until you have selected something, 
then it will be black and usable. 

 
Some menu options will have boxes or circles for you to click on to put a dot or a checkmark in them. 
Round buttons are usually called “radio” buttons because they may allow only ONE of the items on the 
list to be selected. Like car radios you can only push one of the buttons at a time. You can’t listen to two 
stations at once, can you?  Boxes, however, can be checked or unchecked in any combination. After 
making your selections, click on “ok” or “apply” at the bottom. 
 
The bigger and better the program the more options there are available for you. Try playing with some 
menus in a game program or the Paint program just for fun. What you learn will apply to many programs 
and you will enjoy using your computer even more. Once you master how to use menus, go to the Ritz 
and ask for their wine list! 
 

 
 
 


